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1. Intro to PowerPoint 2007 
 
a) About the .pptx  file extension 
By default when you save a file in PowerPoint 2007, it will save it with the .pptx 
extension.  This is the new format introduced in Microsoft Office 2007 documents. It is a combination of 
XML architecture and ZIP compression for size reduction. 
 
Making Office 2003 compatible with Office 2007 files 
If you try to open a .pptx file with PowerPoint 2003 you won’t be able to unless you have 
downloaded and installed the Microsoft Office Compatibility Pack.  To get it, go to 
www.microsoft.com and search for ”office 2007 compatibility pack” 
 
Note, with Powerpoint 2007, you can save a .ppt file that is compatible with Powerpoint 
2003 from within PowerPoint 2007 (choose “Save As”…, then under “Save as Type” 
choose the .ppt format) 
 
b) Menus 
PowerPoint 2007 contains all the features of 2003 and more.  The biggest difference you 
will notice right away is the menus are different.  The way you used to get to various 
menus to do things has changed.  In PowerPoint 2003 menus were at the top of the 
screen, the bottom, and the right side.  And these menus could be moved and placed on 
other sides of the screen or they could float anywhere on the screen.   
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In Power Point 2007 all of the menus are organized at the top of the screen. Instead of 
pull-down  menus that display just words, the menus in PowerPoint 2007 (and in all 
Office 2007 products) have a more graphical look to them.  Small icons give you a visual 
sense of what the menu item is for instead of just reading text.   Everything you need is in 
the top menu bar.  The menu bar is locked down and cannot be moved.  There still are 
some specialized menus on the right-hand side, such as the Custom Animation menu. 
 
Don’t be intimidated by the menu bar. You will notice that when you find where to go for 
a certain function, that the menus that occur on the 2nd level are the same as in 
PowerPoint 2003. 
 
Getting Help Finding menu items 
If you are searching in the new menus and can’t find what you want, try this. 
Microsoft has developed very good support tools for the transition from 2003 to 2007.  
Whenever you can’t find how to do something in 2007, but you remembered where it was 
in 2003, Use the Command Reference Guide on Microsoft’s website. 

 Go to http://office.mircosoft.com 
 In the Search box type:  “powerpoint command reference guide” then search 
 From the search results you will see, a link to the  

”Interactive: PowerPoint 2003 to PowerPoint 2007 Command Reference Guide” 
 Click on it and then bookmark the location in your browser so you can find it 

later. 
 
This guide will show you PowerPoint 2003 and let you click on a menu item. Then it will 
show you PowerPoint 2007 and highlight exactly how to get to the same item using the 
menus in 2007. 
 
c) Some New Features 
 SmartArt Graphics 
 Ability to set a multitude of attributes for text, shapes and pictures such as soft 

edges, reflections, 3D rotations, bevels, glows and shadows just to name a few 
 Quick change view (zoom in or zoom out) slider in bottom right 
 Chart advanced features like changing data on x and y axis 
 PhotoAlbum - Create a slideshow with one picture on each slide very quickly 

with this feature. 
 Add Comments and Mark-ups similar to Word 
 Inking - Add drawings to your slide with the mouse or if you have a table PC with 

a pen on the screen. 
 Protect Presentation  -  Restrict access to presentations 
 Preview your presentation in black and white or grayscale 
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2. Refreshing How to do Some Basic Things /  
    Getting Familiar with the Menus in Powerpoint 2007 
 
- TASK 1: Inserting New Slides – Picking a Layout 

- Select the Home menu  click the New Slide button (#1 below).  A new slide will appear.  Now 
click the Layout pull down menu (#2 below) and choose a slide layout.  
 

 
 

- Type in the text box to create a title or content. 
 
 
 
 
 
- TASK 2: Changing  Attributes of Text 

- Highlight the text you want to edit on screen. 
- Select the Home menu, and then use any of the standard text editing items to make changes 

Specifically check out the Shape Effects and Text Direction for interesting results 
 
 
 
 
 
 
 
- TASK 3:  Adding a Simple Chart 

- Select the Insert menu  click the Chart button and then select the  Type of Chart you want to 
create 

- Automatically, the chart will appear in PowerPoint on the left and the data will appear in an Excel 
spreadsheet on the right as shown below. 

- Sample data is used but you can now Enter your own data into Excel or copy and paste other data 
in. 
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Above note the chart on the left in PowerPoint and the data on the right in Excel.  These are separate 

windows and you can minimize, maximize, resize or close these as needed. 
  

- Next you can now change all attributes of the chart, colors, chart type, change x and y data, etc 
 

3. Animating Objects in PowerPoint 
a. Animating Text 

PowerPoint makes it very easy to use a technique called progressive disclosure, where 
individual bullet points of text are displayed one at a time instead of showing the whole 
slide all at once. 
 
Use progressive disclosure when you want to focus the attention of the audience on the 
point that you are making, rather than presenting them with too much distracting 
information. 
 
To set up a text slide for progressive disclosure, follow these steps: 
- Select the Animation menu Custom Animation…  
- On the right side of the screen the CUSTOM ANIMATION menu will appear.  
Click on Add Effect and then choose what type of effect to add.  
-      Next, look in the CUSTOM ANIMATION menu on the right to alter specific 
settings for the effect such as speed, direction of the effect and when the effect occurs 
(what triggers it). 
 

Animating Chart Data 
- Select the chart by clicking on it.  In the Animation menu, click Custom Animation.  In the right 

hand animation menu, click Add Effect.  Choose an Entrance effect such as Appear or Wipe 
- On the pull-down menu for the Chart animation, select Effect Options… and then open the Chart 

Animation tab 
- Change the option from “As one object” to either “By series”, “By category”, “By element in 

series” or “By element in category” (series corresponds to the rows in the Datasheet, while 
category corresponds to the columns) 
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b. Animating Graphics Objects 
Animation isn’t just limited to flying bullet points and progressive disclosure.  You can 
set up very complex animations within PowerPoint to visually enhance your 
presentations.   
 
The basics to do this are:  
- Select the object you want to animate 
- From the Animations menu (#1 below) choose   Custom Animation (#2 below) 
- The Custom Animation window appears on the right (#3 below). 
- Select Add Effect (#4 below). Select your animation effect. In the example below 

we chose Fly In effect.  The attributes such as direction, speed and timing are in the 
Custom Animation window and can be adjusted. 
 

     
 

In the example above, the “Fly In” entrance effect is chosen.   The blue oval will fly in 
from the Left,  Very Fast when the mouse  is clicked. 

 
- Multiple Effects can be given to a single object AND multiple objects can be animated 
at the same time. 
- Objects can be animated not only for how they enter the screen but also for how they 
exit the screen.    
- Motion Paths or paths that objects should follow can also be created for interesting 
effects. 
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4. Using Images & Videos 
a.  Inserting Images or Clip Art 

You can insert images that you have on your computer 
In PowerPoint choose the Insert menu , then Picture. Browse to your pictures and then 
select one to insert.  To insert Clip Art, just click the Clip Art button instead, choose 
your Clip Art and search and select clip art from the right-hand Clip Art menu.                                                     

 
     

b.  Using Images from the WWW 
The web has many great resources for medical images, just make sure you read and 
understand the acceptable use policy for the website where you are downloading images 
from.  To download an image from the web, right mouse click on the image and a menu 
will appear. Choose Copy from this menu. Then go to a blank slide in PowerPoint and 
from the Edit menu, choose Paste.  Alternately you can simply position both the Internet 
Explorer window and your PowerPoint window side by side and drag the image from the 
webpage to your PowerPoint slide.   Either way, both methods are considered 
downloading so make sure you have permission to do this. 

 
c.   Inserting a Movie into PowerPoint 

You can insert many different formats of movies (video) into PowerPoint, BUT one that 
you cannot insert is a QuickTime movie.   
 

.WMV and .MPG  are the most common formats you can use.   .AVI is an uncompressed 
format, meaning it will be a very large file and take up a lot of PC resources to play.  Try 
to avoid .AVI format video or convert it.  A free program, Windows Media Encoder 9 
(http://www.microsoft.com/windows/windowsmedia/forpros/encoder/default.mspx) 
will allow you to convert .AVI or .MPG files into a smaller .WMV file.  If capturing your 
own video, MPEG or .MPG format will provide a high quality video. 
 

After you have acquired a video clip, you can insert it into PowerPoint by choosing the 
Insert menu,  click on Movie.  In the box that opens browse to your movie and select 
it.   You will be asked if you want the movie to play automatically when the slide comes 
up, or wait for you to click on the movie to start it. 
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Just like images, make sure you proportionately size the movie by clicking on one of the 
CORNER handles and dragging it. 

 
TIP:  You can combine a playing video AND have a list of items progressively disclose 
automatically or as you click the mouse.   Use the “Triggers” button located in the 
“Timing” tab of a custom animation effect. 

 
d. Inserting Sound 

After you have acquired a sound clip, you can insert it into PowerPoint by choosing the 
Insert menu, click on Sound (See image above).  In the window that opens browse to 
your sound and select it.   You will be asked if you want the sound to play automatically 
when the slide comes up, or wait for you to click on the sound to start it. 

 
 

5. Rehearsing Slide Timings and Recording Narration 
Before you begin to do anything with audio, make a copy of your Power Point presentation in a new 
folder.  This way you have the original file (unaltered) somewhere else AND any audio files which 
may be created will all be saved in this new folder. 
 

a. Rehearsing Slide Timings 
PowerPoint provides a way to practice a talk and to keep track of the total time as well as 
the time spent on individual slides.  
-     Select the Slide Show menu  click Rehearse Timings to start the show in 
rehearsal mode 
-     Click the advance button when you're ready to go to the next slide 
-     When you reach the end of the slide show, click Yes to accept the timings or No to 
       start over. 
WARNING: If you click Yes to save, then if you use this presentation, each slide will 
have a time associated with it and the slide will advance automatically.  This is why you 
should work with a copy of your presentation to Rehearse Timings. 
 

b.  Recording Narration 
To record audio narration you will need a microphone.  Plug the mic into the mic input 
jack on your computer.  Double-click the volume icon in your taskbar.  

      This will open the sound mixer.  Make sure the slider labeled 
“Microphone” is about halfway up and it is NOT muted. 
  
Under the  Slide Show menu , choose “Record Narration”.  A box like the one below 
will appear. 
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1) Click on “Change Quality” and next to “Attributes” choose “44.100kHz, 16 bit, 
Mono” from the pull-down menu.   This will create an audio file that is good quality.  
The rule is:  the better the quality, the bigger the file size will be.   
 
2) Click on “Set Microphone Level…”  Follow the instructions to test your microphone. 
You must see the green bar moving to know you have audio going to the PC.  You won’t 
hear your own audio out of the speakers. 
 
3) At the bottom, “Link narration in:…” 
Either choice is OK to use, here is what each will do: 

  If not checked.   The audio will be embedded into the Power Point file.  This will 
create a large .PPT file size.   If you want to edit the audio later, then you will need to 
save the power point file as .HTM which will export the audio as individual .wav files, 
then re-insert each audio clip manually into each slide.  
 

  If checked.   The audio will be saved as an external .wav file in the same folder 
where your power point file is saved.  The actual .PPT Power Point file size will only 
increase slightly.   If you need to edit the .wav files, as long as they are saved in the same 
folder with the same filename, they will stay linked with the correct slide in Power Point.   
  
4) When you are ready to narrate a slide, select “OK” and begin. 
If you are not on the first slide, the message below will appear.  Select the option you 
like.  If you already had audio on the slide, it will be overwritten when you get to that 
slide. 

                                    
 
5) When you want to finish recording, press the “Esc” key.  You will be asked if you 
want to save the slide timings…You must click SAVE. 

           
 
 
  NOTE:  If you want to go back and just re-record only 1 slide… 
  a) Make sure you are on that slide in Power Point, before going into “Record Narration “ 
  b) Record you narration and press “Esc”.  Do not advance the slide to the next one or else 
                                 the audio on that slide will be overwritten. 
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6. Converting your slide show with audio to a web-presentation 
After you have recorded narration with your slides, you can package this for the web.   
We do not recommend that you post a .PPTX or .PPT Power Point file with audio for downloading since it 
may be incompatible with other PC/Mac users.  Also the file size will be very large and not efficient.   It is 
possible to save a Power Point file with audio as HTML, however the results will be various and it may not 
play back in all browsers or on some macs. 
 
Instead, there are several plug-in programs which can help you to record and/or publish your presentation. 
Drexel has site licenses for 2 programs.  Both of these programs use the free universal Adobe Flash Player 
to deliver the slides and media to a user’s computer.  They work on Macs and PCs and in common 
browsers. 
 
A) Impatica for Power Point 
This program is distributed by IRT and is available for download on the IRT software site.  It does a great 
job of converting simple audio and slide presentations. 

- Playback controls can be included 
- Easy to use and quick conversion process 
- Lets you choose between 3 quality settings for audio 
- Various settings to handle videos in your presentation 
- Don’t get a table of contents, but do get next and previous slide buttons. 
- Slides with complex animation or slide transitions may not turn out well 

 
There are several options on 3 screens (tabs) in Impatica.  Experiment and play to see what they do. Or 
follow these QUICK START instructions below and adjust only these items. 
  
On the “Slide Show” tab (see Impatica Screen Shot 1 below) 
1) Add your power point file. 
2) Choose a location and filename.  Impatica will create a filename for you and add –imp.jar to the end of 
it.  It’s good practice to always have only letters, numbers and NO SPACES in the filename.    
TIP:  Create a new folder and save it here.   Impatica will create 3 files when you Impaticize. 
3) Check off the “Include playback controls” option 

 
Impatica Screen Shot 1 
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On the “Media” tab (see Impatica Screen Shot 2 below) 
4) Choose the Sound Format  pull down box.  There are 3 choices to adjust the quality which the sound will 
be set to use.   The higher the quality the larger the file.  I find the middle choice “AU uLaw (5x Compact 
Size) is a good choice. 
 
5) Finally press the “Impaticize” button and let it work.  
 
 
 

 
Impatica Screen Shot 2 

 
 
 
 
 
 
B)  Camtasia 
This program is distributed by IRT and requires that you attend a training session where IRT will load it 
onto your PC 
- Camtasia will capture everything that happens on your screen, in a high quality format so text and image  
   details are very readable  
- You can choose to capture you mouse arrow to show your mouse movements, what you point to, etc. 
- You can choose to capture video (such as a shot of yourself speaking) 
- Various layout templates allow you to arrange where the screen capture and the video window are placed 
- You can display a table of contents when you produce the presentation 
- A lot of controls so this program takes a while to learn what everything does 
- After everything is captured, edited and placed the program needs to render (or publish) the presentation  
   which can take several hours 
 
For more information on Impatica or Camtasia AND to find out when IRT training sessions are held, 
contact   www.drexel.edu/IRT 
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7.   Using Dual Monitors When Presenting 
Your audience will see only your slides (Full Screen) and at the same time you can have your own 
presenter’s console to control your presentation.  On your monitor, you can see your notes for each 
slide, you can preview upcoming slides, you can skip slides, black-out the main screen, etc. 
 

Presenter View (from laptop screen) Audience View (from laptop to a projector) 
    

To use this powerful feature, your computer must be capable of dual monitor support.  Most 
notebook computers with Windows XP have this capability, allowing you to see the presenter’s 
console on your notebook’s screen while projecting just the slides through the external monitor 
port.  You must also know how to select the output of your laptop to go to the external monitor.  
Usually this is done by using a combination of keyboard keys, the “Fn” key and one of the “F” 
button keys.  Look for a monitor-like icon on the key or the words “LCD/CRT”. 
 
To set up your computer for dual monitor support, follow these steps: 
1. Connect a monitor or LCD projector to your laptop’s VGA connector 
2. Even though you connected a monitor or projector in Step #1, make sure you have your laptop 

set so the display is only seen on your laptop screen. 
3. Click the Start menu, point to Settings, click Control Panel, and then double-click the 

Display icon.  
4. On the Settings tab, select the monitor icon for the presenter's monitor (usually 1), and then 

select the Use this device as the primary monitor check box.  
If this check box is selected and unavailable, the monitor is already designated as the primary 
monitor. Only one monitor can be selected as the primary monitor at a time. When you select 
a different monitor icon and complete step 2, this setting for the previous monitor is 
automatically cleared and becomes accessible again. 

5. Select the secondary monitor icon, and then select the Extend my Windows Desktop onto 
this monitor check box.  

6. Click the Apply button. 
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Once dual monitor support has been enabled, you can set up PowerPoint to use it: 
1. On the Slide Show menu, click the Set Up Slide Show button.  
2. Under “Multiple Monitors”, find the Display slide show on list, click the monitor you want 

the show to appear on (for instance, the projector or large monitor, rather than the presenter's 
monitor or laptop).  

3. Select the Show Presenter View check box.  
4. Click OK.  

5. To start the slide show, click the   icon. 
(Note  If you are not using the presenter view, clear the Show Presenter View check box in 
the Set Up Show dialog box, and run the show as you would on a single monitor, clicking to 
advance the slides.) 

6. To move between slides or trigger the next animation, click the arrow buttons. To show a 
slide out of sequence, click a slide in the thumbnail list.  

7. To end the show, click the End Show button. 
 

8.    Using PowerPoint for a Poster Layout 
 

 
You can use PowerPoint to lay out your poster, and then take the Power Point file to a commercial 
graphics house or to a Drexel department with a large format printer for printing. 
 
First figure out how big your poster needs to be.   For our example, we’ll use a final poster size of 
3’ high x 6’ wide or 36” x 72”.    
 
Next, you will need to set-up your Power Point slide for this size.  Select  “File”, then “Page 
Setup”. 
 
The maximum size for a slide show in PowerPoint is 56” x 56”, so if you want your poster to be 6’ 
wide or 72”, you will need to set the width of the page to ½ the final size, then tell the printer to 
print the poster at 200%.   In our example the width would be 36” (1/2 of 72”)  and the height 
would be 18” 
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Now you are ready to start adding a title, authors, DrexelMed logos, pictures, charts, etc. 
TIP: For copies of logos and usage policies, check out the DrexelMed Brand Identity Manual at 
http://www.drexelmed.edu/FacultyandStaffResources/BrandIdentity/NameLogoTrademarks/tabid/
2051/Default.aspx 
 

 
 Choosing the correct size of text   

 
18 pt  72 pt

|--------------------|--------------------|--------------------|--------------------| 
0’  1’ 2’                       3’    4’ 

 
When selecting text size for a poster, keep in mind that posters are generally viewed from a 
distance of 4’ or more instead of 1’ for regular printed material.  Therefore, text on posters should 
be at least 4 times as large (actually only 2 times as large if you will print the final poster double 
size) as you would normally use for a printed document. 
 
It’s best to experience the text size for yourself.  Print out a sample 8.5 x 11 sheet of paper with 
some of the text on it at the actual size that it will be on the poster.  Hang it up and step back 4 feet 
and see how it reads. 
 
 
 
 

 

Use Images and Existing Slideshows in your Poster 

 
Add images with a digital camera or use stock images and clipart from online libraries.  Just make 
sure the image is a high enough resolution so when it prints out it isn’t blurry.  Most digital 
cameras will let you take a high-resolution image.  Most images from websites will be very low 
resolution and not good for printing. 
 
 
 
 
 

 
Use Graphs and Charts 

 
Graphs and charts can also help make a more visual poster.  A good way to include existing 
charts, graphs and even text slides you may already have is to: 

 1st create them in Power Point or open your existing slideshow 
 Export (Save as) each slide as a .PNG or .JPG file 
 Insert these files into your Power Point poster file 
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